
RELEASE NOTES FOR KATANA 1.6V1

Release Date 21 February 2014

System 
Requirements

• Katana 1.6v1 is tested and qualified on Linux 64-bit CentOS/RHEL 5.4

• A graphics card which supports OpenGL shader model 4.0

• A supported renderer (see below)

Supported 
Renderers

Katana 1.6v1 supports PRMan 17.0 and Arnold 4.0.11.0. The supplied 
renderer plug-ins are compiled and tested against these versions. Minor 
version increments of PRMan and Arnold may work, as long as they are API 
compliant with the supported versions. 

To use a version of PRMan or Arnold other than those listed above, you may 
need to recompile the renderer plug-in.

To expose new features and portions, you may need to modify the renderer 
plug-in.

Using a version of PRMan or Arnold other than those listed above may 
produce unexpected behavior. Please note that we can only guarantee to 
respond to Katana bug reports when they are reproducible with the 
supplied versions of the renderer plug-in.

Third Party 
Dependencies

Katana 1.6v1 has dependencies on the following third party libraries:

• OpenEXR 2.0.1

• OpenSSL 1.0.0.a
These libraries are provided in the Katana distribution, in separate
directories under ${KATANA_HOME}/bin

An ABI-compatible copy of these libraries needs to reside on your 

NOTE: A shelf has been added to upgrade scenes from Katana 1.4.x or 
earlier that have baked attribute values for declaring custom PRMan 
display options. For further details, see BUG ID 39491 in the Feature 
Enhancements and Important Changes for 1.6v1 section.



RELEASE NOTES FOR KATANA 1.6V1 2
Feature Enhancements and Important Changes for 1.6v1
LD_LIBRARY_PATH in order for many of Katana's plug-ins to run. The Katana 
application itself uses RPATHs to locate the required libraries.

 Feature 
Enhancements 
and Important 
Changes for 
1.6v1

Enhanced LiveGroup Workflows

There are a number of features designed to make LiveGroups work even 
better in complex shot workflows. These include:

• A dedicated LiveGroup file format with the .livegroup file extension for 
LiveGroup sources. These are held in a purely ASCII format to allow 
comparisons between LiveGroup source files. For compatibility, .katana 
and .macro files will still work when used as LiveGroup sources, but we 
suggest adopting the new LiveGroup file format.

• Editable states for LiveGroup nodes: Instead of converting LiveGroup 
nodes to regular Group nodes and exporting them as .katana files, 
LiveGroup nodes can now be turned into an editable state in which the 
parameters and contents of the node can be modified. This is designed 
to allow editing of LiveGroup nodes in the context of projects in which 
they are used. For example, LiveGroups can be used to define overrides 
for a sequence of shots, these overrides can be edited in the context of 
one of the shots and the changes can be pushed back to be used for the 
whole sequence.

• Enhanced interaction with Asset Management Systems, including the 
ability to test whether the current user has permission to make changes 
to an asset, which is used to check permissions before bringing 
LiveGroup nodes into the editable state.

• Testing for whether changes have been made to any editable LiveGroup 
nodes when saving or closing a Katana project, and allowing you to 
publish them if necessary.

• Improved handling of cases where LiveGroup nodes are nested inside 
other LiveGroup nodes.

NOTE: Katana's wrapper script ${KATANA_HOME}/katana appends 
${LD_LIBRARY_PATH} to ensure these libraries are visible to Katana plug-
ins.

If you manage your own LD_LIBRARY_PATH or wish to expose these 
libraries to plug-ins by some other means, you can call the Katana binary 
directly using:

${KATANA_ROOT}/bin/katanaBin
Katana 1.6v1The Foundry
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Changes in the NodegraphAPI

The NodegraphAPI has been extended with functions to support the 
LiveGroup workflow enhancements:

• CalculateLiveGroupDepth(liveGroupNode) -> int 
Calculates and returns the depth of the given LiveGroup node in the node 
graph taking into account LiveGroup nodes only. Returns -1 if the given 
is not a valid LiveGroup node.

• IsNodeLockedByParents(node) -> bool 
Utility function that, if the contents of any of the given node's parent 
nodes are locked returns True, otherwise returns False.

• ConvertGroupToLiveGroup(groupNode)  
Converts the given Group node to a LiveGroup node.

Changes in the NodegraphAPI.LiveGroupNode Class

The NodegraphAPI.LiveGroupNode has been extended with functions to 
support the LiveGroup workflow enhancements:

• exportAsset(filenameOrAssetID, extraOptions=None) -> str 
Exports a LiveGroup node's contents to the uncompressed XML file with 
the given name or to a file that corresponds to the given asset ID as 
determined by the current asset plug-in.

• getLastSource() -> str 
Returns a previous value of the source parameter.

• getNestedLiveGroupNodes() -> list 
Returns a list of all the child LiveGroup nodes of this node.

• hasModifiedLiveGroupChildren() -> bool 
If the current node has any LiveGroup child nodes which have been 
modified returns True, otherwise returns False.

• isContentLocked() -> bool 
If the node's content is locked to prevent changes returns True, 
otherwise returns False.

• isEditable() -> bool 
If the LiveGroup is in an editable state returns True, otherwise returns 
False.

• isModified() -> bool 
If the LiveGroup node's user parameters or contents have been modified 
returns True, otherwise returns False.

• makeEditable() -> bool 
Attempts to make the LiveGroup node editable and returns True on 
success, otherwise returns False.
Katana 1.6v1The Foundry
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• publishAsset(filenameOrAssetID=None, extraOptions=None) -> str 
A convenience function that calls exportAsset() with the given arguments 
to publish the parameters and contents of the LiveGroup node as a 
LiveGroup source file or asset.

• publishAssetAndFinishEditingContents(filenameOrAssetID=None, 
extraOptions=None) -> str 
A convenience function that calls exportAsset() with the given arguments 
to publish the parameters and contents of the LiveGroup node as a 
LiveGroup source file or asset. It finishes editing the LiveGroup's 
contents, unless publishing failed for some reason.

• reloadFromSource() -> bool 
Reloads the LiveGroup node from its source on disk.

• revert() -> bool 
Reverts the LiveGroup node to the state of the source on disk, if a source 
has been set, or to the state of a freshly created LiveGroup node, if no 
source has been set yet.

• setSource(filenameOrAssetID, loadFromSource=True) 
Sets the value of the source parameter of the LiveGroup node to the 
given filename or asset ID. It also optionally loads the contents of the 
given file or asset into the LiveGroup node.

Changes in the NodegraphAPI.Node Class

The NodegraphAPI.Node has been extended with functions to support the 
LiveGroup workflow enhancements:

• isLocked(), isContentLocked(), isMarkedForDeletion(), and 
isAutoRenameAllowed() -> bool 
The above functions now return a boolean value instead of an integer 
number.

• isLocked(considerParents=False) -> bool 
The boolean considerParents parameter has been added to control 
whether the content locked state of parent Group nodes is taken into 
account. 
Note that child nodes of locked parent nodes are also locked in the UI, 
but can still be modified using the NodegraphAPI, unless they are locked 
themselves.

Changes in the NodegraphAPI.GroupNode Class

• setContentLocked(contentLocked) -> bool 
Locks or unlocks the node's content to prevent or allow changes to child 
nodes.
Katana 1.6v1The Foundry
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Changes in the NodegraphAPI.Port Class

• NodegraphAPI.Port.disconnect()  -> bool 
This function now returns a boolean value, indicating whether 
disconnecting a port connection was successful.

AssetAPI

Two functions have been added to the AssetAPI in order to support 
managing LiveGroup source files as assets in custom asset management 
systems:

• checkPermissions(assetId, context, throwOnError=False) -> bool  
If the asset with the given ID can be edited or published in the given 
context returns True, otherwise returns False.

The optional throwOnError flag determines whether an exception is 
thrown in the case of an error.

• runAssetPluginCommand(assetId, command, commandArgs, 
throwOnError=False) -> bool 
Runs the given custom asset command for the asset with the given ID. It 
is used by the LiveGroupNode class in the NodegraphAPI, when the 
editable state of a LiveGroup node is changed, to call acquireLock and 
releaseLock commands in the selected asset plug-in.

The optional throwOnError flag determines whether an exception is 
thrown in the case of an error.

Support for Alembic 1.5.0

Katana's Alembic_In Scene Graph Generator has been updated to use the 
Alembic 1.5.0 library, which introduces support for reading Ogawa-backed 
Alembic caches.

Support for OpenEXR 2.0.1

Katana has been upgraded to use a custom namespaced version of 
OpenEXR 2.0.1 to resolve a number of issues with library version conflicts. 
The Arnold plug-in that ships with Katana still links against OpenEXR 1.6.1, 
currently provided in $KATANA_HOME/bin/OpenEXR, but both 2.0.1 and 
1.6.1 can exist in the process space without issue.

Miscellaneous

• The End User Licensing Agreement (EULA) that accompanies all The 
Foundry products has been amended. Please see the Katana User Guide 
Appendices for more information.

• In order to support the enhancements to LiveGroup nodes, a new node 
action delegate registry system has been introduced. The node action 
Katana 1.6v1The Foundry
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delegate registry makes it easy to add custom actions to the context 
menu of nodes in the Node Graph tab and/or the wrench menu of nodes 
in the Parameters tab.

To use the new system, define a new class derived from  
UI4.FormMaster.NodeActionDelegate.BaseNodeActionDelegate, imple-
ment the addToContextMenu() and/or addToWrenchMenu() functions, 
and call NodeActionDelegate.RegisterActionDelegate() with the name of 
a node type and an instance of your custom NodeActionDelegate class, 
for example:

class CustomGroupActionDelegate(BaseNodeActionDelegate):
    def addToContextMenu(self, menu, node):
        menu.addAction(...)
    
    def addToWrenchMenu(self, menu, node, hints=None):
        menu.addAction(...)

NodeActionDelegate.RegisterActionDelegate( 
    "Group", CustomGroupActionDelegate())

• BUG ID 33444 - Certain RenderOutputDefine rendererSettings 
parameters, notably cameraName, were ignored for interactive renders 
with PRMan. This prevented interactive stereo camera renders from 
working.

• BUG ID 37131 - The error reporting of exceptions in event handlers has 
been improved. 

Exceptions are now shown as errors instead of warnings, and the name of 
the event handler function is shown in the error message, when available.

• BUG ID 37777 - The warning dialog that displayed when a non-existent 
resolution was set on a RenderSettings node was not clear. The message 
now explains the problem and specifies which RenderSettings node 
produced the warning.

• BUG ID 38446 - The following node-modifying commands in the wrench 
menu and context menu of certain types of nodes were still available for 
locked nodes or nodes that are part of locked Group nodes:

• Edit User Parameters, Finish Editing User Parameters, and Reset 
Parameters on all nodes,

• Display Output Ports on Render and ImageWrite nodes,

• Toggle Group Node Appearance, Show User Parameters At Top Level, 
on Group nodes, 

• Convert to Group on LiveGroup nodes

The commands are now unavailable for nodes that are locked.

• BUG ID 38494 - A new resolveIds parameter has been added to the 
AttributeScript node when applyWhen is set to during attribute modifier 
Katana 1.6v1The Foundry
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resolve. This allows you to resolve an AttributeScript node selectively 
later on.

• BUG ID 38597 - EXR channel names in render outputs can now be up to 
255 characters.

• BUG ID 39218 - Nodes locked by their own lock flag, in addition to one of 
their parent nodes being locked, are now drawn with a more opaque lock 
icon overlay in the Node Graph tab.

It is now possible to create a direct connection between the send and 
return ports of a Group node as a pass-through, which was previously 
only possible by connecting a node in between and deleting that node.

• BUG ID 28954 - The NodegraphAPI.Port.connect() function incorrectly 
returned True when a connection from or to a node within a locked 
Group node or LiveGroup node could not be created.

An invisible connection was incorrectly created when attempting to con-
nect to a locked node that was already connected to another locked node.

An exception was raised when attempting to connect an output port of a 
node to an input port of a node contained in a (nested) locked Group 
node. Parts of the intended connection may have remained in the Node 
Graph.

An exception was raised when attempting to connect an output port of a 
node inside of a (nested) locked Group node to an input port of a node 
outside of the Group node(s). Parts of the intended connection may have 
remained in the Node Graph.

• BUG ID 32756 - Values in top-level color controls were being clamped to 
(1,1,1), even if the Restrict RGB Components option in the associated 
color picker was unchecked.

• BUG ID 34669 - While tile-stitching, the exrcopyrenderattrs command-
line tool failed to copy EXR header information.

• BUG ID 38407 - Outputting a debug file from a locked node resulted in an 
error and no output.

• BUG ID 39371 - Callbacks of the onSceneLoad type were not triggered 
when rendering in batch mode. The order of callbacks during the startup 
process was previously not consistent between the different launch 
modes. For example, in UI mode, a Katana scene file that was passed 
using the command-line argument was loaded before onStartupComplete 
was called, but in batch mode the scene was loaded after 
onStartupComplete.

The order of callback execution during startup has now been unified 
across all launch modes so that scene loading triggers the onSceneLoad 
callbacks prior to onStartupComplete callbacks. The order in which call-
backs are triggered during startup is now:

• onStartup
Katana 1.6v1The Foundry
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• onNewScene (only if a startup scene has not been specified)

• onSceneLoad 

• onStartupComplete

• BUG ID 39491 - The Katana PRMan 17.0 plug-in adds a new shelf script 
to create an AttributeScript node that converts display options set using 
string attributes to group attributes. The update script is available in the 
PRMan17 shelf. This script should only be needed for scenes from Katana 
1.4.x or earlier, if they have baked attribute values that declare custom 
PRMan display options.

To create the AttributeScript node to update display options attributes:

1. Make sure that the PRMan 17.0 plug-in is loaded. See the Installation 
and Licensing chapter in the User Guide for more on this.

2. Click on the Shelf Actions button.

3. Select the shelf named (other) PRMan17.

4. Click on CreateUpdateDisplayOptionsNode.

5. Place the newly created node after the RenderOutputDefine node 
defining the display options.

• BUG ID 39538 - Due to erroneous behavior in the checking of shader 
tags, co-shaders could not be connected to a NetworkMaterial co-shader 
port.

• BUG ID 34987 - When setting the KATANA_KEEP_TMPDIR environment 
variable, the Katana temporary directory of the current session (created 
under KATANA_TMPDIR) is preserved even after Katana exits.

• BUG ID 37131 - Error reporting of exceptions in event handlers has been 
improved. Exceptions are now shown as errors instead of warnings, and 
the name of the event handler function, if available, is shown in the error 
message.

• BUG ID 38441

•   Dialogs related to File menu actions now have titles that correspond to 
the chosen menu action, for example Quit instead of Unsaved 
Changes.

•   Buttons in dialogs related to File menu actions, such as Save and Don't 
Save, now support mnemonics, for example Alt+N for Don't Save.

•   Buttons in dialogs related to File menu actions now appear in default 
order used in the operating system, for example Don't Save, Cancel, 
Save instead of Cancel, Don't Save, Save.

•   The warning dialog that appears when attempting to save a Katana 
project that had been saved in a previous release of Katana now has 
Version Up and Save, Save As and Cancel buttons, instead of Con-
tinue, Choose new name and Cancel.
Katana 1.6v1The Foundry
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• BUG ID 38574 - Added support for fixed and dynamic sized arrays for all 
simple shader parameter types in Arnold, including the following: Int, 
Uniform Int, Float, String, Bool, Byte, RGB, RGBA, Vector, Point, Point2, 
Matrix, Pointer, and Node.

• BUG ID 38794 - When converting a LiveGroup node to a Group node, 
certain types of nodes, for example Render nodes, may have been 
renamed due to having automatically been set based on the values of 
certain parameters, for instance passName.

• BUG ID 39496 - When converting a LiveGroup node to a Group node, if 
values had been added to the farmSettings group parameter of a Render 
node using one of the FarmAPI.AddFarmSetting...() functions, the  
farmSettings values were not preserved.

• BUG ID 39806 - Improvements in the way dynamic array shader 
parameters are shown have been made in the Parameters and Attributes 
tabs:

• Numeric parameters (such as vector or matrix) now only accept 
numeric values.

• Arnold POINTER and LOCATION array parameters now use the  
scenegraphLocation widget type.

• Boolean arrays are now shown with checkboxes.

• Arnold integer types (INT, BYTE, UINT) now only accept integer values.

• Arnold matrices are now shown as a matrix of 4x4 values, not as 16x1 
values.

• BUG ID 38030 - The textual representation of Parameter and Port 
Python objects now contains an "orphaned" text if the Node that they 
belonged to has been deleted, to aid in debugging NodegraphAPI scripts.

• BUG ID 39213 - Menu commands and keyboard shortcuts in the Node 
Graph tab are now unavailable if they cannot be performed on or with the 
currently selected nodes due to nodes being locked.

This also applies to the Edit > Paste command, which is now only avail-
able if non-Unicode text has been copied to the selection buffer clip-
board, and if the contents of the entire project or of an unlocked Group 
node or editable LiveGroup node is being viewed. 

• BUG ID 40112 - AssetWidget context strings were incorrect for Look File 
parameters on the following nodes: LookFileAssign, 
LookFileGlobalsAssign, LookFileBake, LookFileMaterialsIn, 
LookFileMaterialsOut, LookFileOverrideEnable, Material, Gaffer. 

These parameters now use the context provided by  
AssetAPI.kAssetContextLookFile. 

• BUG ID 40142, BUG ID 40376 - Publishing of LiveGroup assets can now 
be customized by adding callbacks of the following new types: 
preLiveGroupPublish, exportAsset, postLiveGroupPublish. 
Katana 1.6v1The Foundry
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Each of the callbacks are passed an instance of the new AssetPublishing 
class, which lives in the NodegraphAPI.LiveGroup module. 

The AssetPublishing object is used to store information about the asset 
publishing operation, and can be used to control it. The callbacks allow 
suppression of file browser, file overwrite confirmation dialogs and log 
messages, and defining custom data-creation operations as part of the 
publishing process.

• BUG ID 40552 - The KATANA_NODETYPETAB_NODETYPES environment 
variable has been added, which can be used to define node type-specific 
Node/... tabs, that allow editing the parameters of nodes of specific 
types. 

The value of the variable is expected to be a list of names of node types 
separated by commas, for example:  
"Gaffer, MaterialStack, LookFileManager, CameraCreate" 

Any whitespace and duplicate commas are stripped from the value of the 
variable. If the variable is not set, the following node type-specific tabs 
are defined by default:  
Node/Gaffer, Node/MaterialStack, Node/LookFileManager

Node type-specific tabs are available in Katana's Tabs menu, in addition 
to being available in the menu of every pane. 

Bug Fixes • BUG ID 19649 - Objects with non-zero pivot values within a 
Transform3D node caused inconsistent behavior when the object was 
manipulated (translated/scaled/rotated) in the Viewer tab.

• BUG ID 22593 - The view or edit flag was incorrectly set on a hovered 
BackdropNote node when pressing V or E while hovering the node in the 
Node Graph tab.

• BUG ID 26369 - When selecting a renderer-specific light shader in a 
Gaffer node, GLSL shader pre-processor errors were displayed when no 
matching GLSL shader existed. The error message has been removed, as it 
is not required that matching GLSL shaders exist.

• BUG ID 31637 - When attempting to add a new node without an input or 
output port, such as a new Render node or a new LiveGroup node, to a 
GroupStack node by clicking the Add Node button in the Parameters tab, 
an exception was raised, and the created node remained in the 
GroupStack without becoming part of the GroupStack's node stack. 

A related known issue still exists and is listed under BUG ID 31637 in the 
Known Issues section. 

• BUG ID 32181 - Arnold only: Matrix values were not output into debug 
*.ass files.
Katana 1.6v1The Foundry
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• BUG ID 34618, 38448 - Bounding boxes were not correctly evaluated for 
PRMan Render Procedurals when the RenderProceduralArgs parameter 
useInfiniteBounds was set to no.

• BUG ID 35334 - An error was logged when loading a LiveGroup on 
startup when using an asset plug-in that was not previously selected.

• BUG ID 35416 - An exception was raised when the readOnly parameter 
hint was set to True for parameters of the assetIdInput widget type.

• BUG ID 36021 - Errors occurring when writing a crash file were not 
reported and crash file saving was disabled for the current session.

• BUG ID 36333 - When pressing the D key over a locked node in the Node 
Graph tab, or over a child node of a non-editable LiveGroup node, the 
node was bypassed.

• BUG ID 36334 - When clicking the auto-key icon of a locked node inside 
of a LiveGroup node, the auto-key icon indicated that auto-keying could 
be toggled.

• BUG ID 36520 - When Live Rendering using PRMan, the Update Selected 
Coordinate Systems action failed to apply the correct transform to the 
coordinate system and would override other live render filters.

• BUG ID 38030 - A crash occurred when deleting a NodegraphAPI.Port 
object that belonged to a node that had been deleted.

• BUG ID 38259 - The function getNumberOfTimeSamples() existed in the 
FnAttribute.h header file but was not implemented. 

This function can now be called from any plug-in.

• BUG ID 38892 - An exception was raised when attempting to import 
everything from NodegraphAPI.InteractiveRenderFilters.

• BUG ID 38941 - Some types of actions were shown with an incorrect row 
height in the Undo History tab.

• BUG ID 39276 - PRMan clipping planes were being constructed with an 
incorrect xform.

• BUG ID 39564 - Values of dynamic array shader parameters for PRMan 
co-shaders were lost when saving and reloading a Katana project.

• BUG ID 39616 - When hiding and showing the Parameters tab some 
widgets in the tab were not disabled for array parameters of locked 
nodes.

• BUG ID 39619 - Dragging a child node of a LiveGroup node or a locked 
Group node into the node list of a GroupStack or GroupMerge node in the 
Parameters tab incorrectly adopted the dragged nodes.

• BUG ID 39623 - A Cannot Adopt Node error message dialog was shown 
with a message of None when attempting to adopt a node by a 
LiveGroupStack node.

• BUG ID 39642 - The Cannot Adopt Node dialog, that was shown when 
attempting to adopt a GroupStack node within itself, incorrectly 
Katana 1.6v1The Foundry
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mentioned the GroupMerge node type instead of the GroupStack node 
type.

• BUG ID 39688 - In the shader network pop-up window of 
NetworkMaterialParameterEdit nodes in the Parameters tab and the 
material group attributes in the Attributes tab, the shading nodes that 
define coshaders were not shown.

• BUG ID 39801 - PRManRendererInfo incorrectly declared the 
DisplayChannel quantize parameter as float rather than int, resulting in 
the following warning:

"R09046 {WARNING} Unexpected declaration for parameter "quantize" of

displaychannel "<channel name>", expected type int[4]"

• BUG ID 39832 - When switching from a default to a local value in the 
Parameters tab, values of array parameters, such as cropWindow of a 
RenderSettings node, were not updated correctly.

• BUG ID 39874 - Certain functions of ViewerModifierInput (the 
ViewerModifierAPI) have now been fully implemented: getAttribute(), 
getGlobalAttribute(), getLiveAttribute(), getWorldSpaceXform(), 
getLiveWorldSpaceXform(), isLiveAttribute(), isLiveWorldSpaceXform().

• BUG ID 40167 - The visibility flag was not taken into account for 
instances within the PRMan plug-in. 

• BUG ID 40184 - It was possible to delete and rename input and output 
ports of non-editable LiveGroup nodes using the Delete Port and Rename 
Port commands in the context menu of ports in the Node Graph tab. 

• BUG ID 40186 - When deleting an input or output port of a Group node, 
the entry in Katana's Undo History incorrectly read “Rename Port on 
<node name>”. It now reads “Delete <Input/Output> Port “<node 
name>.<port name>”.

• BUG ID 40419 - The Gaffer node's InheritedMute child node contained an 
incorrect CEL parameter expression string. 

• BUG ID 40465 - When browsing for a file with a relative filename, 
Katana's file browser dialog returned the selected file with an absolute 
filename, instead of keeping relative filenames relative, leading to issues 
with asset management systems that use relative filenames as asset IDs. 

• BUG ID 40490 - Enabling caching in the PRMan procedural caused 
renders to fail.

Procedural caching can be enabled by setting the limitProducerCaching 
attribute: 

renderSettings.producerCaching.limitProducerCaching = IntAttribute(1)

This causes the scene graph iterators pointing to bounded locations to be 
stored into the procedural's caching system.

You can control the size of the cache by setting the following attributes:
Katana 1.6v1The Foundry
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renderSettings.producerCaching.geometricCacheInputQueueLength = 
IntAttribute( <size> ) - Determines how large the stage-1 cache should 
grow before evicting items to the stage-2 cache.

renderSettings.producerCaching.geometricProducerCacheLimit =  
IntAttribute( <size> ) - Determines how large the stage-2 cache should 
grow before evicting items permanently from the cache.

The above settings allow you to control RAM usage during renders with 
large numbers of nested procedurals in a deferred expansion.

• BUG ID 40554 - When reloading a LiveGroup node from its source while 
editing parameters of any of its child nodes in node type-specific Node/... 
tabs, the selections of those child nodes in the Node/... tabs were not 
retained.

Known Issues • BUG ID 40709 - The Alembic library does not support multiple process or 
thread access to an Alembic file. This means that a crash occurs when 
modifying an Alembic file outside Katana, while it's loaded in an open 
Katana scene. To avoid this, you must Flush Caches before attempting to 
update any modified Alembic files..

• BUG ID 40600 - Undoing a revert of an unpublished LiveGroup node does 
not restore the LiveGroup's editable and modified state.

• BUG ID 40599 - User parameters of non-editable LiveGroup nodes can 
incorrectly be edited.

• BUG ID 40598 - Reverting a LiveGroup node does not revert its user 
parameters.

• BUG ID 40538 -When scene graph locations are constrained to other 
scene graph locations, geometry drawn for them by Viewer Modifier Plug-
ins (VMPs), for example bounding boxes or guide geometry for lights, is 
incorrectly shown in the Viewer tab even when the locations are not 
expanded in the Scene Graph tab.

• BUG ID 40237 - Nodes can be dragged into the Group bubble of a non-
editable LiveGroup node. 

• BUG ID 39261 - Operations that lock and unlock nodes do not currently 
create entries in the undo history, which can lead to an incorrect Node 
Graph state when undoing and redoing operations.

NOTE: In the event that a scene graph iterator is requested from the 
cache and not found (due to eviction), the iterator is regenerated by 
walking the scene from the closest common ancestor already in the 
cache.
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• BUG ID  38861 - Light Link exceptions are not supported during Live 
Render.

• BUG ID 37477 - Adding an invalid path to the ImageRead node causes 
Katana to crash.

• BUG ID 37256 - When using the RGBA widget type, RGB values in the 
color picker are reset to 0 when the alpha is 0, which is the alpha’s 
default value.

• BUG ID 36926 - The rendererSettings > displayOptions parameter of a 
RenderOutputDefine node for the PRMan renderer, shown when its type 
parameter is set to raw, cannot be set using the Parameters tab.

For a workaround, see the steps listed in BUG ID 39491.

• BUG ID 36691 - State badges are currently shown for attribute values of 
dynamic array child parameters, even though only their parent array 
parameter should appear with a state badge.

• BUG ID 36663 - It is not currently possible to sort notifications in the 
Notifications window.

• BUG ID 36225 - The UpdatePrmanSettingsNode shelf script does not 
currently deal with expression parameters. Locally set parameter 
expressions on PRMan nodes will need re-adjusting after running the 
shelf script.

• BUG ID 36176 - The 2D node Disk Render Upstream Render Outputs 
option does not use the batch render method, batchRender, for upstream 
render nodes, instead it is using diskRender.

• BUG ID 36170 - Control keys (notably arrow keys) do not function as 
expected in shell mode.

• BUG ID 34870 - Katana doesn't support render output directory creation 
for shadow, merge and script output types.

• BUG ID 34289 - The render log output may contain superfluous newlines.

• BUG ID 34274 - When using Reyes mode in PRMan Live Rendering, lights 
are duplicated when sending live render updates.

• BUG ID 34256 - Preview Rendering 2D nodes fails when Disk Render 
Upstream Render Outputs is set to Unless Already Cached. In addition, a 
crash sometimes occurs when attempting to repeat the Preview Render.

• BUG ID 33242 - Live Rendering is not designed to work with rapid 
updates to region of interest (ROI), and may cause unexpected behavior.

• BUG ID 32125 - Live Rendering complex scenes using anything other 
than Selected Scenegraph Locations can result in Katana crashing.

• BUG ID 31790 - In the Parameters tab, setting an expression for an array 
or a group parameter currently breaks the parameter's UI.

• BUG ID 31637 - When adopting a Macro-based node into a GroupStack 
node, the node type of the GroupStack is set to the node type of the 
Macro, but not the name of the Macro, which means that new instances 
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of the Macro cannot be created by clicking the Add Node button in the 
Parameters tab. For a workaround, duplicate an existing Macro-based 
node in the GroupStack node's item list.

A related bug has been resolved and is listed under BUG ID 31637 in the 
Bug Fixes section. 

• BUG ID 31257 - The keyboard shortcut for Edit > Toggle Ignore State of 
Selected Nodes command in the Node Graph tab is Alt+D, not D. This 
overrides the Alt+D keyboard shortcut of the Unconnected to Viewed 
Node menu item. The D key toggles the ignore state of a single node 
under the cursor.

• BUG ID 30170 - The --crop-rect and setDisplayWindowToCropRect 
command-line options do not currently work, so nothing is cropped. 

You can work around this issue by adding a RenderSettings node to your 
Katana scene with the cropWindow parameter set. This allows you to 
render using a cropped display window in batch mode.

• BUG ID 28549 - Main menu commands that create nodes, notably 

File > Import..., File > Import LiveGroup..., and Help > I want a pony, do 
not create the nodes in a Group or LiveGroup node that has been entered 
in a Node Graph tab. Instead they create the nodes in the root level of the 
node graph document.

• BUG ID 27147 - Due to an internal bug in Qt 4.7.2 an error message 
similar to the following may occasionally be displayed in the console: 
"Application asked to unregister timer 0x13000076 which is not 
registered in this thread. Fix application." 
(https://bugreports.qt-project.org/browse/QTBUG-16175)

• BUG ID 22296 - Due to a known issue with PRMan, Katana does not 
currently support PRMan Live Rendering with AOVs. 

For a workaround, to allow Live Rendering, disable AOVs in interactive 
renders by applying an Interactive Render Filter, using a RenderSettings 
node with the interactiveOutputs parameter set to just primary.
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